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SUMMARY 

Surgical site infections are an area of concern for hospitals, doctors, and surgical 

patients.  Several years ago, sophisticated computational fluid dynamics (CFD) research 

conducted by the National Institutes of Health concluded that a buoyant flow generated 

from the patient’s body heat would be able to sufficiently prevent airflow, which could 

carry infectious particles, from impinging directly on the surgical site under 

recommended conditions.  The suspected buoyant thermal was found to be a stagnation 

region of warm air or a slowly circulating three-dimensional vortex driven by a 

temperature gradient.  The study presented in this thesis aimed to experimentally 

determine the airflow patterns around a patient in an operating room and to determine the 

effect, if any, of the buoyant flow.  In addition, independent CFD analysis was conducted 

to compare with the experimental results and determine if standard CFD simulations can 

reliably predict the airflow around the surgical site. 

The results from both the experimental data and the CFD analysis indicate that the 

buoyant flow probably does not play a dominant role in protecting the surgical site under 

normal operating room conditions.  Further research should be done utilizing particle 

tracking to determine to flow of particles within the airflow of the hospital operating 

room. 
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1. INTRODUCTION 

Surgical Site Infections (SSI) are a significant and potentially preventable source 

of illness and death for surgical patients.  A study done by the Centers for Disease 

Control (CDC) reported that 2.6% of all operations were complicated due to SSI [1].   

This means that of the 27 million surgical procedures done in the United States every 

year [2], almost 700,000 will lead to SSI for the patient.  It has been estimated that each 

occurrence of SSI increases the procedure costs by $5,000 [3].  This means SSI are 

responsible for an approximately $3.5 billion drain on the health care industry, and this is 

only the amount the hospital experiences.  The full cost, including time away from work, 

degraded lifestyle, suffering, and death, is surely much higher.  Surgeons and other health 

professionals have focused on more effective medical approaches to preventing 

infections, such as proper hygienic practices and prophylactic antibiotics.  These 

techniques have proven very effective, but SSI still occur in surgery patients.  An 

unknown, but probably substantial, number of those infections are caused due to airborne 

bacteria present in the operating room (OR), which could be minimized with an optimal 

configuration of the OR ventilation system. 

Microorganisms from within or on the patient’s body cause many infections for 

surgical patients, but a significant number of the remaining cases are attributed to 

airborne exogenous (external to the body) organisms.  The most common pathogen 

responsible for SSI is Staphylococcus aureus, which was isolated in 48% of patients with 

SSI in a study done by Kirkland [3].  Staphylococcus aureas is a Gram-positive spherical 

bacteria, meaning it retains a crystal violet dye during the Gram stain process [4].  
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Staphylococcus aureas is commonly found on normal human skin [5]. The transmission 

of Staphylococcus aureas is especially troubling due to the fact that in recent years, 

several strands of the bacteria have been found that are resistant to traditional antibiotics 

[5]. 

Released skin flakes, or squames, from exposed regions of the surgical staff and 

patient are the primary transportation mechanism for bacteria in the OR [6].  These 

squames have been found to be approximately 25 microns (μm) in diameter by 3 to 5 

microns thick.  It has been estimated that approximately 1.15 million to 90 million 

squames are released into the OR during a typical two hour surgery [6].  The traditional 

Heating, Ventilating, and Air-Conditioning (HVAC) solution to prevent the transmission 

of infections in this fashion has been to dilute and remove infectious particles from the 

OR by increasing the air flow rate into the room [7]. 

Various OR ventilation techniques have been developed and implemented 

through the years.  The most prominent OR configuration is vertically downward flow, 

but horizontal parallel flow and trumpet-shaped down and outward diffusing flow are 

also represented.  The recommended air speeds in these different configurations vary 

significantly from 30 feet per minute (FPM) to as much as 100 FPM.  This wide disparity 

in recommended flow rates, as well as the abundance of ventilation configurations, has 

led to confusion over which HVAC system is the most effective at preventing infections. 

1.1. History of Operating Room Ventilation 
The first “clean rooms” were established by the United States Air Force during 

World War II for the assembly of gyroscopes and bomb-sights [8].  With the advent of 

atomic weaponry came the need for even cleaner clean rooms.  This led to the 
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development of the laminar air flow “ultra-clean” room in 1960 [8].  Laminar air flow is 

referred to as such in the medical field, but a more accurate description is parallel air 

flow.  The first parallel air flow clean room was a horizontal flow room built at Sandia 

Laboratories in Albuquerque, NM [8].  Parallel flow was produced by forcing air through 

high efficiency particulate air (HEPA) filters, which was able to filter out 99.97% of 

particulates 0.3 micrometers or more in diameter [8]. 

 
Figure 1.1: Example Parallel (Laminar) Air Flow Configuration 

In December 1961, discussions began to use the newly developed clean room for 

medical applications.  Bacterial studies were started in April 1962 in the parallel air flow 

clean room at Sandia Laboratory and were reported in 1965 [8].  These studies concluded 

that a parallel air flow operating room configuration would reduce the possibility of 

airborne contamination from pathogenic bacteria.  On the basis of those studies, the first 

vertical parallel air flow system was installed in an OR in Bataan Memorial Hospital in 

Albuquerque, New Mexico and began operating on January 3, 1966 [8].  Since that time, 

Surgical Patient 

Perforated 
Plate Diffuser 

Return Air 
Grill (2 
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parallel air flow systems have become the dominant airflow configuration for hospital 

operating rooms; however, a number of different configurations are represented and 

confusion exists as to which configuration is optimal to prevent infections. 

1.2. ASHRAE Guidelines For Hospital Operating Rooms 
In 2003, the American Society of Heating, Refrigerating and Air-Conditioning 

Engineers (ASHRAE) published guidelines on OR air distribution in its HVAC Design 

Manual for Hospitals and Clinics.  These guidelines were based on innovative 

computational fluid dynamics (CFD) modeling and simulations done by Dr. Farhad 

Memarzadeh and Dr. Andrew Manning [9]. This CFD research found that a buoyant 

flow, generated by the patient’s body heat, could play a significant role in protecting the 

surgical site from pathogens present in the operating room [9].  The conclusion of the 

research was that vertically downward parallel flow with a face velocity of 30-35 FPM 

(0.15-0.18 m/s) at the ceiling-mounted diffuser exit and low returns or a combination of 

low and high returns is the best OR air distribution design [9].  The CFD simulations, 

however, were not confirmed by direct experimental work. 

This paper focuses on experimentally determining the airflow patterns around a 

patient in an OR and the influence of buoyancy.  Particle Image Velocimetry (PIV) 

technology was used extensively in this study in order to generate the flow data around a 

simulated patient.  The experimental work was conducted in an operating room simulator.  

A considerable amount of work was put in to constructing the operating room and 

calibrating the flow rate entering the room.  The experimental setup is described in 

Section 2, and information about the experimental runs is given in Section 4. 
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Independent CFD analysis was also performed as part of this investigation into 

the influence of buoyancy above a surgical site during normal operating room conditions.  

This independent CFD analysis was done using a standard commercial CFD program 

both to help guide and interpret the experimental results and to test the performance of a 

more readily available tool in predicting the experimental findings.  The CFD analysis is 

detailed in Section 5. 

Four different cases were considered as part of this study.  Runs were done for 

two different flow rates: 330 cubic feet per minute (CFM) and 420 CFM.  These two flow 

rates correlate to inlet velocities of 12.56 FPM (.064 m/s) and 15.99 FPM (.081 m/s), 

which is lower than the face velocity recommended by Dr. Memarzadeh.  A simulated 

patient in the center of the experimental setup was either heated or left at ambient 

temperature in order to determine the effect, if any, of buoyancy above the surgical site. 

In Dr. Memarzadeh’s analysis, the surgical site was assumed to be 100°F (37.8°C) [9], 

which is close to the typical body core temperature of 98.6°F (37°C) [10].  This 

temperature, however, was found to be inaccurate.  Field tests performed by Dr. Jeter and 

Dr. Goldman found that the surgical site temperature was approximately 85°F (29.4°C) 

during surgery [11].  For the experimental runs, the simulated patient was heated to 85°F 

(29.4°).  The buoyant flow should dominate with the patient heated under the described 

flow conditions. 

1.3. Buoyancy 
Two separate forms of convective transport exist: natural and forced.  Both of 

these transportation modes exist in the air flow around a patient in an operating room, 

which results in a mixed convection flow regime.  Buoyant flows, or natural convection, 
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are driven by a density gradient between the source fluid and its surroundings.   Buoyant 

flows are generally divided into two groups: plumes or thermals.  A plume is defined a 

continuous buoyant flow between the source and the level of interest [27].  A thermal is a 

sudden release of a buoyant region of fluid.  The buoyancy, in the case of a thermal, 

remains confined to a limited volume, which rises and loses its connection with the 

source [27].  Detailed observations show that the flux from a heated boundary is 

intermittent rather than steady.  Buoyant fluid tends to slowly accumulate at the surface 

and then break away, either as a thermal, or as an unsteady plume that wanders about the 

surface [27].  The flow seen by Dr. Memarzadeh in his CFD research would indicate the 

existence of a stable buoyant plume above the surgical site. 

Much of the research done in the field of buoyancy has focused on aiding forced 

and natural convection effects.  The opposing effects, like those seen in an operating 

room, have not been considered in comparable detail [26].  A derivation of the effect 

buoyancy has on a mixed flow was shown by Gebhart [26]. Consider an upward laminar 

flow of a uniform stream (U∞, T∞) over a flat vertical surface with a length of L.  The 

surface temperature, Ts, is taken as a uniform temperature greater than T∞.  The buoyancy 

forces will aid the forced flow in this situation.  The flow is illustrated in the following 

figure. 



 7

  
Figure 1.2: Illustration of Aiding Buoyant Flow 

The coordinates are defined such that x is positive up.  Gravity, g, is defined as 

being downward.  The x-direction component of the Navier-Stokes equation, with 

uniform properties except for buoyancy, can be defined as [26]: 

 )(1 2
∞−−∇+

∂
∂

−=+
∂
∂ TTgu

x
p

dy
duv

x
uu sβν

ρ
 (1.1) 

  
This equation can be normalized by introducing several dimensionless parameters [26]. 
 

 
L
xX =           

L
yY =           

∞

∞

−
−

=
TT
TT

s

φ           
2/2

∞

∞−
=

U
P

ρ
ρρ  (1.2) 

 
∞

=
U
uu'           

∞

=
U
vv'            

222' ∇=∇ L
 

 
Substituting in the dimensionless parameters and simplifying results in the 

following equation [26]. 

 φυ
υ

βυ
22

2

2

3
2 )(''

2
1''

LU
TTLgu

LUX
P

Y
uv

X
uu s

∞

∞

∞

−
+∇+

∂
∂

−=
∂
∂

+
∂
∂  (1.3) 

The last term of the equation can be recognized as the Grashof number divided by 

the Reynold’s number squared.  This indicates that the buoyancy effect will be 

comparable to the forced flow effects if the coefficient   is of the order 1, as well as the 

convective terms.  The ratio of the Grashof number to the Reynold’s number squared is 

Ts 

T∞, U∞ x 

g 
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also defined as the Archimedes number, which simplifies as shown in the equation 

below. 
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The magnitude of the Archimedes number indicates the relative effect of 

buoyancy on forced convection.  High values of this quantity, on the order of 10 or 

above, indicate significant buoyant effects in the flow [26].  The calculation of this 

number, however, can be fairly ambiguous.  The length scale that should be used is 

undefined.  In addition, the upstream velocity is not completely defined.  For the 

purposes of this research, the face velocity at the diffuser exit was used; however, due to 

recirculation regions within the experimental setup, which will constrict the flow above 

the patient, the velocity upstream of the patient is surely higher than the face velocity.  

The Archimedes numbers were calculated for each of the four experimental cases, but are 

presented in this thesis for reference only. 
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2. GEORGIA TECH OPERATING ROOM SIMULATOR 

The research presented in this thesis made extensive use of the Georgia Tech 

Operating Room Simulator (ORS).  The ORS simulates the area around a patient during 

surgery, called the surgical zone, not an entire operating room (OR), as shown internally 

in Figure 2.1.  The ORS was designed and built to investigate the airflow patterns above a 

surgical patient in an operating room with a vertically downward parallel air distribution 

system, which can be found in a large number of hospital operating rooms in the United 

States.  Particle Image Velocimetry (PIV) measurements were used to determine velocity 

fields of particles above the surgical site. 

 
Figure 2.1: ORS in Comparison to Entire Hospital Operating Room 

2.1. Operating Room Simulator 
The ORS consists of an approximately 8 foot cubic room that is supplied with air 

via a 3 x 3 array of 24 inch diffusers installed in the center of the room ceiling.  The inlet 

diffusers are perforated plate diffusers which are commonly used in ORS construction.  

Air is exhausted from the room through two 21 inch (height) x 96 inch (width) return air 

grilles, which are installed 8.5 inches from the ground on either side of the ORS.   

Typical 20 ft by 20 ft 
by 12 ft height OR 

Eight foot cubic ORS 
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The rate of airflow into the room is controlled by a Titus PESV-12 pneumatic 

single-duct Variable Air Volume (VAV) terminal unit installed in the air supply duct, 

which can be adjusted up to 1200 cubic feet per minute (CFM) airflow.  Each diffuser is 

supplied with a dedicated line that branches off of a main plenum.  Each diffuser supply 

line contains a damper and averaging Pitot tube flow measuring station to monitor and 

control the air flow to each perforated diffuser.  A simplified 2-dimensional schematic of 

the ORS is shown in Figure 2.2.   

 
Figure 2.2: Simplified Schematic of the Georgia Tech Operating Room Simulator 

(ORS) 
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Simulated Patient 

PIV Laser 
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A flow schematic that shows which damper valve supplies each diffuser in the 

ORS is illustrated in the following figure.  In addition, the fog injection points, which are 

described in the next section, are shown. 

                     
Figure 2.3: ORS Flow Schematic 

In the center of the ORS is a water-filled aluminum vessel, which simulates a 

patient’s chest cavity.  The simulated patient is located 56 inches (1.4 m) downstream of 

the ceiling inlet diffusers.  The temperature of the simulated patient can be adjusted by 

using a water heater pump (Brookfield EX-200), which is installed outside the room and 

 

  

   

 
 

 

Plenum

 
VAV  
Box 

9 Perforated 
Plate Diffusers 

9 Damper 
Valves 

Inlet Flow

Fog Injection 
Points  



 12

connected to the patient via plastic tubing.  For a run in which the surface temperature of 

the patient was to be approximately 85°F (29.4°C), the water inside the patient is warmed 

to approximately 100°F (37.7°C). 

In order to use a particle image velocimetry technique to evaluate the velocity 

fields of the flow above the patient’s surgical site, the air must be seeded with neutrally-

buoyant particles.  Seeding the flow without influencing flow patterns is a significant 

challenge.  The flow into the ORS is seeded by feeding a low-pressure flow through a 

copper tube, which is submerged in a fog-generating fluid.  The submerged tube end is 

crimped, which forces the air to pass through 4 1/32-inch (0.79 mm) holes that are drilled 

into the tube.  This method is very similar to fog generation with a Laskin Nozzle [12], 

which is commonly used for PIV measurements.  A photo showing the modified Laskin 

Nozzle installed on the ORS is shown in the figure below. 

 
Figure 2.4: Modified Laskin Nozzle Installed in ORS 

For the Georgia Tech ORS, Rosco Fog Fluid is used as the fog-generating fluid.  

As the air bubbles up through the fog-generating fluid, small particles of the fog are 

separated from the fluid reservoir turning the flow into an aerosol.  The aerosol fluid is 

then injected into three diffusers in the room – in two locations in the center diffuser, and 

Fog-Generating 
Fluid 

Laskin Style 
Nozzle 
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one location each of other two diffusers, as shown in Figure 2.3.  An overall schematic of 

the fog-generating system is shown below in Figure 2.5. 

 
Figure 2.5: Schematic of Fog Generating System 

The aerosol is injected into the diffusers by employing nozzles installed in the 

ceiling of the ORS.  The arrangement of the nozzles inside the diffuser is illustrated in 

Figure 2.6. 

 
Figure 2.6: Arrangement of Fog Nozzles Inside ORS Diffuser 

In order to isolate the ORS from its surrounding environment, a significant 

amount of insulation was recently added.  The ORS was initially constructed with ¼ inch 

(6.4 mm) foam board insulation, which was sufficient to isolate the room with respect to 

convective mass transfer from the surroundings, but it did very little to protect the ORS 

Main Flow 

Diffusers 

Laskin Style 
Nozzle 

Fog-Generating 
Fluid 
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from thermal conduction.  A substantial amount of insulation was added in the form of 

glass fiber insulating panels, specifically Owens Corning QuietR Duct Board, which has 

an R-value of 0.76 m2-K/W [13].  The duct board was added to the outside of the ORS 

frame, which left a 1.5-inch (38.1 mm) gap of air between the exterior of the foam board 

and the inside surface of the duct board.   

 
Figure 2.7: Illustration of Insulation Addition 

The addition of the duct board with an air gap significantly raised the R-value of 

the room insulation.  The R-value of insulation is calculated by employing the equation 

shown below, R is the R-value, kt is the conductivity of the material, and x is the width of 

the material.  The R-value of different insulations in series is found by summing up the 

individual R-values. 

 
tk

xR =  (2.1) 

Using the R-value of a 1.5-inch gap of air from the ASHRAE handbook as 0.44 

m2-K/W [14], the R-value of duct board as 0.76 m2-K/W, as previously mentioned, and 

the R-value of foam board as 0.11 m2-K/W [15], it was found that the R-value of the 

insulation for the room increased from 0.11 m2-K/W to 1.31 m2-K/W.  This increase was 

important to thermally isolate the room from the surrounding environment.  Pictures of 

the ORS before and after the addition of the insulation are shown in the figures below. 
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Figure 2.8: Operating Room Simulator Before the Addition of Glass Fiber 

Insulating Panels 

 
Figure 2.9: Operating Room Simulator After the Addition of Glass Fiber Insulating 

Panels 

The temperature at various locations throughout the room is monitored 

continuously during an experimental run.  Nine K-Type thermocouples are installed 

inside the ORS.  They are located as follows: 2 in the inlet, 2 in the open air, 1 installed 

on the patient, 2 on the left side exhaust, and 2 on the right side exhaust.  These 

thermocouples are read and the data from them is collected by using an Agilent 34907A 

Data Acquisition/Switch Unit and Agilent Benchlink Data Logger software to monitor 
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and log the temperature data.  This data was used in the computational fluid dynamics 

(CFD) simulations.  The thermocouples were calibrated in order to ensure high quality 

readings during experimental runs.  The thermocouple locations are shown below in 

Figure 2.9. 

 
Figure 2.10: Thermocouple Locations in the ORS 

Numbers shown are the assigned channel of the thermocouple, as shown in Table 2.1 

In addition to the thermocouples installed in the room, the flow into the room is 

also continuously monitored during a run.  The magnitude of the velocity is not 

monitored as much as the continuity of the flow to ensure that there are no spikes in the 

air flow.  The flow is monitored by measuring the voltage potential induced in a modified 

analog Alnor Thermo-Anemometer.  Each of the thermocouples and the thermo-

anemometer are assigned a channel in the Agilent Data Acquisition/Switch Unit.  The 

channels assigned for each component are shown in the table below. 
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Table 2.1: Channel Settings in Data Logger 
Channel Device Measurement Location Units 

1 Alnor Thermo-Anemometer Flow rate in duct upstream of plenum VDC 
2 K-Type Thermocouple Ambient temperature outside ORS °C 
3 K-Type Thermocouple Back-left diffuser inlet temperature °C 
4 K-Type Thermocouple Center diffuser inlet temperature °C 
5 K-Type Thermocouple Back-right exhaust temperature °C 
6 K-Type Thermocouple Front-right exhaust temperature °C 
7 K-Type Thermocouple Front-left exhaust temperature °C 
8 K-Type Thermocouple Back-left exhaust temperature °C 
9 K-Type Thermocouple Open air on left-side of ORS °C 

10 K-Type Thermocouple Open air on right-side of ORS °C 
11 K-Type Thermocouple Simulated Patient surface temperature °C 

2.2. Air Flow Rate 
The most critical part of the experimental setup is the ability to carefully control 

the flow rate of air entering the ORS.  The flow into the room is determined using an 

averaging pitot-tube (Dwyer Mark II) installed in the inlet duct, just upstream of the 

VAV box, and a Dwyer 1” manometer.  It is possible to derive a relationship between the 

static pressure and the flow rate analytically using Bernoulli’s Equation, as shown in 

Equation 2.2. 

 ghVP ρρ ++ 2

2
1 = constant (2.2) 

Assuming that there is a negligible change in elevation, Equation 2.2 reduces to 

Equation 2.3, which relates the pressure measured by the pitot tube to the velocity of the 

flow in the duct. 

 
ρ

PV Δ⋅
=

2
  (2.3) 

The term ΔP can also be written as qD, or the dynamic pressure.  Equation 2.3 can 

be further developed to find a relationship between the volumetric flow rate and the 

dynamic pressure, as shown in Equation 2.4. 
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ρ

D
cc

qAVAQ ⋅
⋅=⋅=

2
 (2.4) 

Using the parameters for the ORS, the following equation is obtained. 

 
DqQ ⋅= 2205  (CFM) (2.5) 

where qD is measured in inches of water column. 

An experimental relationship between the gage pressure measured by the pitot 

tube and the overall flow rate was developed in order to confirm the analytical 

relationship.  The experimental relationship was developed by doing traverses using a 

digital thermal anemometer [16].  In a traverse, measurements are taken with a flowmeter 

or a pitot tube at different distances from the center of the tube, as shown in Figure 2.10. 

 
Figure 2.11: Locations of Flow Measurements [17] 

The average of the velocities gathered is used to calculate the overall flow rate 

through the duct, as shown in Equation 2.5.  The assumption used for applying traverses 

to determine the flow rate through a duct is that the flow is fully turbulent. 

 ∑
=

⋅⋅=
n

i
iduct v

n
AQ

1

1  (2.6) 

Due to the importance of developing a reliable relationship between the static 

pressure and the flow rate, measurements were taken at four distances from the duct 

center in both the horizontal and vertical directions.  The ratios used to determine the 

locations and the locations themselves are shown below in Table 2.2. 
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Table 2.2: Locations Used for Flow Rate Traverse Measurements 

Distance from 
Center (r/D) 

Radius 
(in) 

0.177 2.124 
0.306 3.672 
0.395 4.74 
0.468 5.616 

Measurements were taken with the pitot tube at multiple qD readings.  The square 

root of the pressure was plotted against the calculated flow rate through the duct.  Linear 

regression was done on the data in order to determine the best fit curve, as shown in 

Figure 2.11.  
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Figure 2.12: Plot of Measured Flow Rate Versus the Square Root of qD

 

Equation 2.7 was derived by linear regression of the data. 

 152117 ±⋅= DqQ  (CFM)  (2.7) 
This equation agrees fairly well with Equation 2.5.  The uncertainty obtained from 

linear regression is ±15 CFM, which is less than 5% of the flow at 330 CFM.  This 

equation was used to calculate the flow for experimental runs. 
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In order to confirm the relationship developed by the traverse, direct 

measurements of the flow rate from each duct were conducted with an Alnor 

“Balometer” air balancing hood.  This test also shows how well the diffusers are 

balanced, since an even flow from each diffuser is desired.  Figures 2.8 and 2.9 show the 

results of the Alnor measurements.  The numbers shown are in cubic feet per minute 

(CFM) of air passing through each diffuser in the ORS diffuser array. 

 
Figure 2.13: Flow Balance Through Each Diffuser at Calculated Flow Rate of 330 

CFM 

The summation of the flow is 310 CFM 
The average flow through each diffuser is 34.4 CFM 

The greatest delta is 5.5 CFM or 16% from the average 
 

 
Figure 2.14: Flow Balance Through Each Diffuser at Calculated Flow Rate of 420 

CFM 
The summation of the flow is 425 CFM 

The average flow through each diffuser is 47.2 CFM 
The greatest delta is 7.2 CFM or 15% from the average 
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2.3. Camera Positioning System 
A unique feature of the Georgia Tech ORS is the camera positioning system.  The 

camera positioning system makes it possible to take PIV measurements at multiple 

locations without entering the room.  This is paramount because entering the room would 

cause disturbances in the airflow within the room.  The camera positioning system allows 

for movement in both the X and Y direction.  A schematic of the positioner system is 

shown in Figure 2.14. 

 Stepper 
Motor with 
Worm Gear 
Box 

Sprocket Rod End 
Bearing 

Camera 
Trolley 

Stepper 
Motor with 
Belt Pulley 

Linear 
Bearing 

Camera 

 
Figure 2.15: Camera Positioning System 

The horizontal positioner is a belt-driven trolley on a rail.  The belt is attached to 

a computer-controlled Superior Electric stepper motor, model number M061-LF-544, 

which is capable of microstepping.  The stepper motor drives the toothed belt to position 

the trolley.  The vertical positioner is a chain hoist.  Another computer-controlled 
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Superior Electric stepper motor drives the input of a worm-gear right angle gear box, 

which has a reduction ratio of 60:1, at the top of the positioner.  The output of this gear 

box drives the horizontal shaft at the top of the positioner.  Sprockets are attached to both 

ends of the shaft.  The horizontal positioner is attached to an ANSI number 25 chain 

which runs over the sprocket and to a counterweight.  The rotation of the sprocket will 

raise or lower the horizontal trolley rail.  Vertical guides, which are linear ball bearings 

engaging vertical guide bars, maintain horizontal alignment.  The supporting structure is 

constructed out of Unistrut.  The vertical supports are bolted directly into the ceiling of 

the ORS.  The horizontal support is bolted between the two vertical supports.  A picture 

showing the camera positioning system is shown in Figure 2.15. 

 
Figure 2.16: Camera Positioning System 

The stepper motors are driven with Cyberpak, model CY-21, stepper motor 

controllers.  These controllers are each supplied with 30VDC to ensure the highest 

possible performance of the motors.  The controllers are triggered by the parallel port of 

the controlling computer.  The Cyberpak controllers required three inputs from the 

Trolley Rail 

Gear Box for 
vertical drive 

Chain Hoist 

Vertical Guide 
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computer:  Enable, Direction, and Step.  Enable is hardware inverted such that a low 

signal on the enable pin enables the motor.  The motor is made to step once every time 

the step pin is made high.  The wiring of the pins to the parallel port can be found in the 

figure below.   

 
Figure 2.17: Stepper Motor Controller Wiring Diagram 

 The DB-25 connector wired to the controllers is connected to the parallel 

port on the computer (LPT1 or Address 0x378).  The parallel port is manipulated using a 

program running within Matlab.  A graphical user interface (GUI) was also made for this 

program.  Because a programming wizard (Guide) was used to create the GUI, the details 

of it will be omitted.  To drive the stepper motor, the proper value is written to the 

parallel port periodically.  The code used to drive the X and Y controllers can be found in 

the Appendix E.  This program takes in a non-zero displacement.  The first step in the 

program is to gain access and configure the computer’s parallel port.  Next, the direction 

is found by determining the sign of the input displacement.  Finally, a loop is used to 

repeatedly set the value of the port to the proper value (for the horizontal controller this is 
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8*direction+1) and zero.  For the Y controller, a delay loop is needed to prevent the 

motor from missing steps.  This is done by putting a dummy loop into the main loop.  

This dummy loop simply makes the computer count to 300000 before it repeats the 

instructions in the main loop. 

Within the Matlab stepper program, 25 preset positions plus a reference home 

position are defined.  PIV measurements are taken at the 25 preset positions above the 

simulated surgical patients.  The positions are numbered from the bottom-left to the 

upper-right and are illustrated in the figure below.   

X

Z

600 800 1000 1200 1400 1600

1000

1200

1400

1600

1800

 
Figure 2.18: Locations of Zones for 25-Point Run 

Zones are numbered from bottom-left to upper right 
Axes are in mm 

The coordinate system used to define the dimensions used is located at the lower 

left corner of the ORS.  The overall area of measurement is from approximately 960 mm 

to 1875 mm in the z-direction by 886 mm to 1500 mm in the x-direction.  Each zone is a 

section approximately 80 mm wide by 60 mm tall (3.1 inches wide by 2.4 inches tall) in 
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the plane of the PIV laser.  The laser plane is located approximately 1100 mm in the y-

direction, which means it is 1100 mm from the front wall of the ORS.   
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3. PARTICLE IMAGE VELOCIMETRY 

3.1. PIV Background 
Particle Image Velocimetry (PIV) is a very sophisticated but straight-forward 

method of determining the velocity of particles in a flow field.  The particles of a seeded 

flow are illuminated by two quick, successive pulses from a laser light sheet.  The pulsed 

laser is typically a dual cavity solid state laser such as a neodymium-doped yttrium 

aluminum garnet (Nd:YAG) ruby laser.  A high-resolution (1360 x 1036 pixels) Charge-

Coupled Device (CCD) camera is used to capture photographs of the light reflected from 

the laser off of the seeded particles.  The camera and the double-pulsed Nd:YAG laser are 

connected to a host computer via a controller, which controls the timing of the laser 

illumination and the image acquisition.  Velocity vectors are determined from each frame 

pair by employing cross-correlation statistical analysis to determine the movement of the 

particles between pulses [18].  Figure 3.1 shows how the movement of a particle is used 

to determine a velocity vector.   

 
Figure 3.1: Particle Movement Between Pulses Results In Vector Shown on the 

Right 

The velocity of the particles is calculated by dividing the distance traveled by the 

particles by the time separation of the pulses, as shown in the following equation.  

 

1 

2 
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pulset
dV =  (3.1) 

The PIV method is derived from Laser Speckle Velocimetry, which is a method 

used to analyze solid surface movements [19].  Using PIV, it is possible to track the 

motion of many different particles and populate entire flow fields. 

The software program proVISION-XS is used to capture multiple picture pairs 

and average vectors are determined for the flow of particles through the field of the 

capture region.  An Integrated Design Tools (IDT) controller is used to relay the 

commands from the host computer to the PIV laser.  Once the data is captured and 

analyzed with proVISION, Tecplot is used to graphically interpret the raw data in order 

to view the vector flow fields.  For the data presented in this thesis, a sequence of 30 

images (15 image pairs) was taken and the average velocity field was computed at each 

location.  A 20 by 20 grid of 400 two-dimensional vectors was determined and plotted in 

Tecplot.  An example flow field is shown in Figure 2.3 below. 
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Figure 3.2: Example Vector Field from PIV Results 



 28

3.2. Camera and Laser Settings for a Run 
The settings for the camera and laser are integral to getting good results from a 

PIV system.  The pause between pulses was set such that particles would move 

approximately 3-5 pixels between picture pairs.  Other values, such as the laser frequency 

and camera frequency, were adjusted to achieve high quality pictures of the particles in 

the flow.  A table showing the camera and laser settings is shown below. 

Table 3.1: Camera and Laser Settings 

Exposure [μs] 234 
Pulse Separation [μs] 1000 
Laser Frequency [Hz] 15 
Camera Div 30 
Laser Frequency [Hz] 15 
Camera Freqency [Hz] .5 

3.3. PIV Verification 
In order to verify that the measurements taken by the PIV system were correct, a 

calibration of the PIV laser measurement system was performed.  The idea was for the 

PIV system to take measurements of an object moving at a known speed.  Data would be 

collected and processed as flow data would be for an experimental run.  From there, it 

would be possible to compare the velocities from the experimental data to the known 

velocities. 

3.3.1. Verification Device 
An effective way to simulate objects moving would be to slowly rotate a disc that 

is lightly dusted with corn starch, similarly to how the air flowing through the room is 

seeded with fog.  A 12 inch diameter disc was made out of one half inch thick particle 

board.  This disc was rotated by an 18 RPM gear motor, which was mounted on an 

adjustable height camera stand.  A picture of the rotating device is shown in Figure 3.3.   
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Figure 3.3: Gear Motor with Rotating Verification Disc  
The rotating disc was positioned in the ORS in the same plane as the PIV laser.  

This would give a good comparison between the verification results and the experimental 

results obtained during test runs.  A picture showing the configuration of the verification 

device in the ORS is shown in the figure below. 

 
Figure 3.4: Rotating Disc Positioned in the Plane of the PIV Laser 

It is a straight forward calculation to find the velocity at any point on a rotating 

disc by multiplying the rotational speed by the radius from the center of rotation, as 

shown in Equation 3.2. 

 ω⋅= rV  (3.2) 

PIV 
Camera

Rotating 
Disc 

Gear 
Motor 

Rotating 
Disc 
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3.3.2. Verification Test Runs 
ProVISION software was used to perform the laser-velocity measurements.  

ProVISION was set to take measurements at the same settings that are used for a fluid 

flow measurement.  The pictures were then analyzed, again by proVISION, and the data 

was compiled in the same manner as a fluid flow measurement would be compiled. 

Two verification test runs were performed on the rotating disc, with each test 

taking measurements at a different location on the disc. The velocities determined for 

each run was compared to expected velocities.  The pictures of the areas of the disc 

considered for each verification run are shown in the following pictures. 

 
Figure 3.5: PIV Verification Run 1 

Area of the disc between 0 and about 8 cm from the center of rotation 
Numbers shown are the distance from the center of rotation in centimeters 
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Figure 3.6: PIV Verification Run 2 

Area of the disc from 4 to about 12 cm from the center of rotation 
Numbers shown are the distance from the center of rotation in centimeters 

3.3.3. Verification Results 
The data was collected and analyzed in the same fashion as data would be 

collected and analyzed for a typical fluid flow run.  Plots from Tecplot for each of the 

two runs are shown in the following figures. 
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Figure 3.7: Plot of Velocity Vector Field for Verification Run 1 

Vectors shown are magnitude of velocity in m/s 
Center of rotation is located at (0,0) 

Arcs shown are lines of constant radius 
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Figure 3.8: Plot of Velocity Vector Field of Verification Run 2 

Vectors shown are magnitude of velocity in m/s 
Center of rotation is located at (0,0)  

Arcs shown are lines of constant radius 
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During data processing, the velocity is broken down into the x-direction velocity , 

u, and the y-direction velocity, v.  In order to compare the PIV-measured velocities with 

the calculated expected velocities, the neutral line was found.  The neutral line is defined 

as the line where the u velocity was minimized, meaning that velocity was contained 

almost entirely in the v component.  The magnitude of the velocity, calculated using 

Equation 3.3, for neutral line were plotted against the radius. 

 22 vuV +=   (3.3) 
The plots of the measured velocity versus the radius are shown in the figures 

below. 
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Figure 3.9: Radius versus Measured Velocity for PIV Verification Run 1 
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Figure 3.10: Radius versus Measured Velocity for PIV Verification Run 2 

Linear interpolation was performed on the verification data.  A curve was fit to 

the data and a constant was derived to compare with the calculated angular velocity, ω, of 

1.885 radians/second.  For the first verification run, a constant of 1.892 was calculated 

with an uncertainty of 1.58 x 10-3.  For the second verification run, a constant of 1.871 

was calculated with an uncertainty of 1.74 x 10-3.  This shows that the PIV measurements 

agree very well with expected results. 
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4. EXPERIMENTAL TEST RUNS 

Experimental test runs were conducted using the Georgia Tech Operating Room 

Simulator (ORS).  Six runs were done for each case: 330 CFM - Patient at ambient, 330 

CFM – Patient heated to approximately 85°F, 420 CFM – Patient at ambient, 420 CFM – 

Patient heated to approximately 85°F.  The temperatures at the locations outlined in 

Section 2.1 were continuously monitored using the Agilent Benchlink Data Logger.  

These temperatures were used for the computational fluid dynamics (CFD) analysis.  The 

flow into the ORS was monitored continuously to ensure that the proper airflow was 

supplied to the room throughout the experimental runs. 

A strict procedure, shown in Appendix D, was followed for each run in order to 

maintain consistency for all runs.  The camera and laser settings used are shown in 

Section 3.2.  The same settings were used for all experimental runs.  Representative plots 

for each of the four cases are shown in the figures below. 
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Figure 4.1: Representative Plot of 330 CFM, Patient Cold Case 

X

Z

800 1000 1200 1400 1600 1800

1000

1200

1400

1600

1800
Vmean

0
-0.02
-0.04
-0.06
-0.08
-0.1
-0.12
-0.14
-0.16
-0.18
-0.2

Frame 001 ⏐ 12 Nov 2007 ⏐ 7-25-07 330 CFM, Patient Warm

 
Figure 4.2: Representative Plot of 330 CFM, Patient Warm Case 
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Figure 4.3: Representative Plot of 420 CFM, Patient Cold Case 
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Figure 4.4: Representative Plot of 420 CFM, Patient Warm Case 

As can be seen, Zone 3, directly in the center of the patient, is a stagnation region 

for all cases.  It is difficult to see what is happening around the simulated patient.  

Contour plots of the six zones (zones 3, 4, 5, 7, 8, and 9) around the patient are shown 

below.  If the plots are compared between the patient at ambient conditions to the patient 
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heated, a small increase in the stagnation region upstream of the patient can be observed.  

However, there was no evidence on any of the heated runs of a dominant buoyant thermal 

like those observed by Dr. Memarzadeh in his CFD analysis, which used 100°F as the 

temperature of the surgical site.    
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Figure 4.5: Contour Plot of Patient Region for 330 CFM, Patient Cold Case 
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Figure 4.6: Contour Plot of Patient Region for 330 CFM, Patient Warm Case 
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Figure 4.7: Contour Plot of Patient Region for 420 CFM, Patient Cold Case 
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Figure 4.8: Contour Plot of Patient Region for 420 CFM, Patient Warm Case 

The results from the experimental runs were very consistent.  Tecplot images of 

all the experimental runs are included in Appendix A.  In addition, average vectors for 

each zone were calculated for each run.  These average vectors were plotted on top of 

each other and are supplied in Appendix B.  These average plots demonstrate the 

consistency of the experimental runs. 

4.1. Additional Test Runs 
Additional test runs were conducted with the simulated patient heated to 100°F 

and are included in this thesis.  Pictures of 330 CFM with the patient heated to 100°F and 

420 CFM with the patient heated to 100°F are shown in the figures below. 
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Figure 4.9: Experimental Results from 330 CFM, Patient 100°F 
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Figure 4.10: Experimental Results from 420 CFM, Patient 100°F 

During the experimental run, it was noted that the buoyant flow did in fact 

dominate under these flow conditions.  In the case of 330 CFM, with the patient heated to 

100°F, there was a distinct swirl in the airflow above the patient.  This results in non-

symmetric flow.  The general path of the flow is superimposed on Figure 4.9.  Contour 
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plots of the patient region show a significant region of stagnation around the simulated 

patient, as shown in the following figures. 
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Figure 4.11: Contour Plot of Patient Region for 330 CFM, Patient 100°F 
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Figure 4.12: Contour Plot of Patient Region for 420 CFM, Patient 100°F 
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5. COMPUTATIONAL FLUID DYNAMICS ANALYSIS 

As part of the investigation into the existence of a dominant buoyant flow above a 

surgical site under normal operating room conditions, a Computational Fluid Dynamics 

(CFD) analysis was conducted.  FLUENT software was used to conduct this analysis.  

The results from the CFD analysis were qualitatively and quantitatively compared to the 

experimental results. 

5.1. Computational Fluid Dynamics Background 
The modeling of the flow inside the operating room simulator (ORS) is developed 

by applying the conservation equations of continuity, momentum, and energy.  The 

choice of a suitable turbulence model is very important to obtaining reliable results.  The 

equations used to model the turbulence in the flow are included. 

5.1.1. Continuity and Momentum Equations 
The conservation equations for flow in an Eulerian reference frame in the absence 

of external forces consist of the continuity equation [20]: 

 ( ) 0=⋅∇+
∂
∂ v

t
ρρ  (5.1) 

 
as well as conservation of momentum [20]: 

 ( ) ( ) ( )τρρρ ⋅∇−+−∇=⋅∇+
∂
∂ gPvvv
t

 (5.2) 

where ρ is the density, v is the velocity vector, P is the static pressure, ρg is the 

gravitational body force, and τ  is the stress tensor. 

5.1.2. Energy Continuity Equation 
The energy equation can be written as: 
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where E is the total energy of the flow, defined in the following equation. 

 
2

2VphE +−=
ρ

 (5.4) 

where h is the enthalpy of the flow, p is the pressure of the flow, ρ is the density 

of the air, and V is the magnitude velocity of the flow. 

5.1.3. Turbulence Modeling  
The realizable k-ε model was used to model the turbulence in the fluid flow for 

this study.  The realizable k-ε model is a more sophisticated model than the standard k-ε 

model, which is used extensively in CFD.  The standard k-ε model is a semi-empirical 

model based on writing transport equations for the turbulence kinetic energy (k) and the 

turbulence dissipation rate (ε).  The standard k-ε model, however, over predicts the 

effects of eddy viscosity.  The realizable k-ε model was developed by Shih [21] to correct 

this issue.  The turbulence kinetic energy, k, and its rate of dissipation, ε, for the 

realizable turbulent transport condition are obtained from the following equations [21]: 
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The terms that appear in these equations are defined next.  Gk is the generation of 

turbulent kinetic energy due to the mean velocity gradients and is defined in the 

following equation. 
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Gb is the generation of turbulent kinetic energy due to buoyancy and is defined for 

perfect gases as: 

 
it

t
ib x

gG
∂
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ρ
μ
Pr

 (5.8) 

YM is the contribution of the fluctuating dilation in compressible turbulence to the 

overall dissipation rate. 

 22 tM MY ⋅⋅= ερ  (5.9) 
where Mt is the turbulent Mach number. 

C1ε, C2, are constants, and 
kσ  and 

εσ  are the turbulent Prandtl numbers for k and 

ε, respectively.  The following values are used during FLUENT analysis 

2.1 ,0.1 ,9.1 ,44.1 21 ==== εε σσ kCC  [21]. 

C3ε is defined as: 

 
⊥

==
u
uC tanh3ε

 (5.10) 

where =u is the component of the flow velocity parallel to the gravitational vector 

and ⊥u  is the component of the flow velocity perpendicular to the gravitational vector. 

C1 is defined by the following equation [21]: 
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5.2. Computational Fluid Dynamics Analysis Methodology 
The boundary conditions used were taken from measurements collected during 

the experimental runs.  The thermocouples used to collect these data points were located 
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in the room as shown in Figure 2.5 (Section 2).  Several calculations were done with the 

experimental data in order to aid with the CFD analysis. 

The Boussinesq density was found for each of the cases.  The Boussinesq 

approximation of the density helps get a faster convergence for buoyancy-driven flows 

than when density is defined as a function of temperature.  The Boussinesq model in 

FLUENT treats the density as a constant value in all solved equations except for the 

buoyancy term in the momentum equation.  The Boussinesq approximation is defined as 

[20]: 

 )1( ToB Δ⋅−= βρρ  (5.12) 
where oρ  is the ambient density of air (1.2 kg/m3), β is the thermal expansion 

coefficient, which was previously defined, and TΔ  is the temperature difference between 

the inlet air and the surface of the simulated patient. 

The thermal coefficient of expansion, β, is defined by the equation below, which 

simplifies to the inverse of the absolute temperature for an ideal gas. 

 
TT
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ρ

ρ
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The boundary conditions used for the four different cases are shown in the 

following table. 

Table 5.1: Operating Conditions 
330 CFM,

Patient Cold
330 CFM,

Patient Warm
420 CFM,

Patient Cold
420 CFM,

Patient Warm
u in  (m/s) 0.064 0.064 0.081 0.081
T in  (K) 288.5 288.8 288.5 288.6
T room  (K) 288.9 289.4 288.9 289.1
T out  (K) 289.1 289.5 289.0 289.3
T patient  (K) 288.9 303.6 289.0 304.5
β  (1/K) 0.00346 0.00346 0.00346 0.00346

ρ B  (kg/m3) 1.22 1.16 1.22 1.16
Ar 0.15 36.09 0.23 24.07  

The Archimedes numbers calculated are shown here for reference only. 
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The heat flux through the walls was calculated from the experimental data in 

order to include it in the CFD analysis.  This was done by employing the following 

equation. 

 )( inoutp TTCm
A
Qq −== &
&

&  (5.14) 

where q&  is the heat flux per unit area, Q&  is the total heat flux, A is the wall area, 

m&  is the mass flow rate of the air in the room, 
pC  is the specific heat at constant 

pressure, and Tout and Tin are taken from the measured boundary conditions.  See 

Appendix F for heat flux calculations done with Engineering Equation Solver software. 

The heat flux through the ORS walls was found to be 7.05 W/m2 and was applied 

as a boundary condition to the model.  An illustration of the boundary conditions taken 

from the experimental data and applied to the CFD analysis is shown in the figure below. 
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Figure 5.1: Definition of Boundary Conditions Used for Analysis 

A 3-dimensional model of the Georgia Tech ORS was developed in Gambit and 

analyzed in FLUENT.  The model was dimensioned to the same dimensions as those of 

the physical ORS.  A Tet-hybrid mesh was used for the mesh construction in Gambit.  

The mesh consisted of 554,093 cells with the mesh being very dense around the 

simulated patient.  The cell volumes were between 8 x 10-8 and 8 x 10-5 m3.  A picture of 

the mesh is shown in Figure 5.2 below.  The interior mesh is not shown for clarity.  
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Figure 5.2: Gambit Mesh of ORS 

Several different meshes were tested before the mesh used for this analysis was 

developed, including several structured grid.  The structured grids, however, were 

unsuccessful in meshing the geometry of the ORS.  The unstructured Tet-hybrid mesh 

was able to efficiently model the flow.   In practice, an unstructured Tet-hybrid mesh 

would be the easiest mesh to use, and in simulating realistic and complicated geometry, 

the unstructured grid is likely to be the only feasible option. 

To couple the pressure and velocity and ensure continuity is satisfied, the 

SIMPLE algorithm was employed to obtain a numerical solution of the momentum 

equations.  The SIMPLE algorithm in FLUENT uses a procedure similar to the one 

outlined by Rhie and Chow [24].  Using this method, the face value of velocity is not 

averaged linearly.  Momentum-weighted averaging, which uses weighting factors, is 

performed. 

3 x 3 Diffuser Inlet 

Simulated Patient

Exhaust 
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The PRESTO! (PREssure STaggering Option) solver was used for the pressure 

continuity solver.  This solver uses a staggered control volume about the face to compute 

the staggered pressure [25].  This solver is recommended by Fluent for buoyant flows 

[22].  The second order momentum, turbulent kinetic energy, turbulent dissipation, and 

energy discretizations were utilized to discretize the governing equations.  The numerical 

solution was found to a convergence accuracy of 1 x 10-4 (kg/s and m/s) for the continuity 

and velocity terms for each of the four cases.  In addition, a convergence accuracy of 1 x 

10-7 W was achieved for the energy equation. 

5.3. Computational Fluid Dynamics Analysis Results 
The data from FLUENT was exported and Tecplot was employed to visualize the 

flow inside the ORS model.  The flow of the CFD results in the same plane as the 

experimental results is shown the following figures. 
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Figure 5.3: CFD Results for 330 CFM, Patient Cold in Region of Experimental 

Results 
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Figure 5.4: CFD Results for 330 CFM, Patient Warm in Region of Experimental 

Results 
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Figure 5.5: CFD Results for 420 CFM, Patient Cold in Region of Experimental 

Results 
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Figure 5.6: CFD Results for 420 CFM, Patient Warm in Region of Experimental 

Results 

As can be seen in these results, the flow is predominantly downward vertical flow 

with a small stagnation region upstream of the patient.  There is not a significant 

difference in the stagnation region between the patient heated and the patient at ambient 

conditions.  This indicates that a dominant buoyant thermal does not exist above a 

surgical site under these conditions.  Tecplot windows of the entire plane of the 

experimental results for the four cases are included in Appendix C. 

5.4. Comparison with Experimental Results 
A comparison of the experimental results and the CFD results was performed to 

determine how well the two agree.  This was accomplished by partitioning the CFD 

results into the same zones as those used for the PIV measurements using Tecplot.  The 

numbers determined by Tecplot linear interpolation can be written to a text file.  Using 

those numbers, it is possible to find an average velocity (in the u and v components) for 
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each zone using Excel.  These numbers can then be directly compared with the average 

velocities obtained through the experimental runs. 
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Figure 5.7: Comparison of CFD Zone Averages with Experimental Zone Averages 

for 330 CFM, Patient Cold Case 

Experimental Zone Averages are shown in Black 
CFD Zone Averages are shown in Red 
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Figure 5.8: Comparison of CFD Zone Averages with Experimental Zone Averages 

for 330 CFM, Patient Warm Case 

Experimental Zone Averages are shown in Black 
CFD Zone Averages are shown in Red 
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Figure 5.9: Comparison of CFD Zone Averages with Experimental Zone Averages 

for 420 CFM, Patient Cold Case 
Experimental Zone Averages are shown in Black 

CFD Zone Averages are shown in Red 
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Figure 5.10: Comparison of CFD Zone Averages with Experimental Zone Averages 

for 420 CFM, Patient Warm Case 

Experimental Zone Averages are shown in Black 
CFD Zone Averages are shown in Red 

As can be seen from viewing Figures 5.7 through 5.10, the CFD results agree very 

well with the experimental results in both magnitude and direction of the average vectors 

in each experimental zone.   

In addition to the qualitative comparison of the results shown above, a 

quantitative comparison was done.  This was done by taking the difference between the 

FLUENT results and the experimental results.  This number was squared and the sum of 

the difference squared was found for all 25 zones and then divided by the average 

velocity found by adding the two results and dividing by 2.  The overall error for the 

whole area was found by using Equation 5.11. 
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The errors found by using this analytical comparison are shown in the table 

below. 

Table 5.2: Root-Mean Squared Error Between Experimental Results and CFD 
Results 

Case RMS Error 
330 CFM, Patient Ambient 6.1 % 
330 CFM, Patient Heated 5.1 % 

420 CFM, Patient Ambient 4.2 % 
420 CFM, Patient Heated 4.4 % 

It is interesting to note that the results obtained from a conventional and 

commercially available CFD modeling and simulation package were in good agreement 

with the results obtained from experiments.   
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6. CONCLUSION 

Surgical site infections are a significant area of concern for surgical patients.  

Under recommended hospital operating room ventilation conditions, a buoyant flow may 

develop from the heat of the surgical site and may help prevent infections.  The aim of 

this thesis was to determine the role of the buoyant flow in preventing antibodies and 

bacteria from entering the surgical site during an operation.  An experimental and a 

numerical study were conducted as part of this investigation.  The cases considered were 

for 330 cubic feet per minute (CFM) and 420 CFM volumetric airflow rates entering the 

experimental setup.  A simulated patient was either heated or left at ambient conditions to 

determine what effect the patient’s heat has on airflow impinging on the surgical site. 

The Georgia Tech Operating Room Simulator (ORS) was used extensively in the 

collection of experimental data.  The ORS is arranged to emulate the parallel downward 

airflow system commonly found in hospital operating rooms.  Data were collected from 

25 zones upstream of a simulated patient in the ORS employing Particle Image 

Velocimetry (PIV) technology.  The results of the experimental runs indicate that when 

the surgical site is maintained at a realistic temperature (85°F), the buoyancy probably 

did not play a dominant role in preventing the airflow (which could possibly be carrying 

infectious particles) from impinging directly on the surgical site during steady state 

conditions.  However, when the temperature of the surgical site was raised to 100°F, a 

dominant buoyant flow was observed. 

Temperature and flow measurements were taken from the experimental runs and 

applied as boundary conditions for the numerical model.   A 3-D model of the ORS was 
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developed and analyzed using FLUENT software.  It is notable that a relatively 

conventional CFD modeling and simulation package was able to produce results that 

agreed very well with the experimental data. 

From the results obtained as part of this study, it was observed that a buoyant flow 

generated from a patient’s own body heat did not seem to protect the surgical site from 

impinging airflow.  Therefore, it is recommended that a method of active patient air 

control be developed.  The Georgia Tech ORS should be further utilized to determine the 

effect active patient air control has on airflow patterns in a hospital operating room. 

It is acknowledged that no attempt was made to track simulated infectious 

particles in this research.  Such an effort would be far beyond the current scope of effort 

and resources.  It is recommended that experimental particle tracking imaging be 

conducted to evaluate the effectiveness of various air distribution designs in protecting 

the patient.   Such experimental results should be compared with particle tracking 

simulations, which will require transient CFD simulations that are far outside the scope of 

this work. 
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APPENDIX A – EXPERIMENTAL TEST RUN RESULTS 

330 CFM – Patient Cold 
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 Figure A.1: Detail Velocity Vectors for Figure A.2: Detail Velocity Vectors for 
 330 CFM, Patient Cold Experimental Run 330 CFM, Patient Cold Experimental Run 
 Performed on 7-17-2007 Performed on 7-17-2007 
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 Figure A.3: Detail Velocity Vectors for Figure A.4: Detail Velocity Vectors for 
 330 CFM, Patient Cold Experimental Run 330 CFM, Patient Cold Experimental Run 
 Performed on 7-24-2007 Performed on 7-28-2007 
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 Figure A.5: Detail Velocity Vectors for Figure A.6: Detail Velocity Vectors for 
 330 CFM, Patient Cold Experimental Run 330 CFM, Patient Cold Experimental Run 
 Performed on 7-28-2007 Performed on 7-28-2007 
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330 CFM – Patient Warm 
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 Figure A.7: Detail Velocity Vectors for Figure A.8: Detail Velocity Vectors for 
 330 CFM, Patient Warm Experimental Run 330 CFM, Patient Warm Experimental Run 
 Performed on 7-19-2007 Performed on 7-19-2007 
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 Figure A.9: Detail Velocity Vectors for Figure A.10: Detail Velocity Vectors for 
 330 CFM, Patient Warm Experimental Run 330 CFM, Patient Warm Experimental Run 
 Performed on 7-19-2007 Performed on 7-25-2007 
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 Figure A.11: Detail Velocity Vectors for Figure A.12: Detail Velocity Vectors for 
 330 CFM, Patient Warm Experimental Run 330 CFM, Patient Warm Experimental Run 
 Performed on 7-25-2007 Performed on 7-25-2007 
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420 CFM – Patient Cold 
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 Figure A.13: Detail Velocity Vectors for Figure A.14: Detail Velocity Vectors for 
 420 CFM, Patient Cold Experimental Run 420 CFM, Patient Cold Experimental Run 
 Performed on 7-16-2007 Performed on 7-17-2007 
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 Figure A.15: Detail Velocity Vectors for Figure A.16: Detail Velocity Vectors for 
 420 CFM, Patient Cold Experimental Run 420 CFM, Patient Cold Experimental Run 
 Performed on 7-20-2007 Performed on 7-20-2007 
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 Figure A.17: Detail Velocity Vectors for Figure A.18: Detail Velocity Vectors for 
 420 CFM, Patient Cold Experimental Run 420 CFM, Patient Cold Experimental Run 
 Performed on 7-24-2007 Performed on 7-24-2007 
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420 CFM – Patient Warm 
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 Figure A.19: Detail Velocity Vectors for Figure A.20: Detail Velocity Vectors for 
 420 CFM, Patient Warm Experimental Run 420 CFM, Patient Warm Experimental Run 
 Performed on 7-18-2007 Performed on 7-18-2007 
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 Figure A.21: Detail Velocity Vectors for Figure A.22: Detail Velocity Vectors for 
 420 CFM, Patient Warm Experimental Run 420 CFM, Patient Warm Experimental Run 
 Performed on 7-19-2007 Performed on 7-19-2007 
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 Figure A.23: Detail Velocity Vectors for Figure A.24: Detail Velocity Vectors for 
 420 CFM, Patient Warm Experimental Run 420 CFM, Patient Warm Experimental Run 
 Performed on 7-25-2007 Performed on 7-26-2007 
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APPENDIX B – AVERAGE PLOTS FOR THE FOUR CASES 

330 CFM – Patient Cold Average Plot 
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Figure B.1: Averaged Velocity Vectors for 330 CFM, Patient Cold Case 

The data points from each individual run are color-coded as shown 
The average vector from all the runs is black 
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330 CFM – Patient Warm Average Plot 
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Figure B.2: Averaged Velocity Vectors for 330 CFM, Patient Warm Case 

The data points from each individual run are color-coded as shown 
The average vector from all the runs is black 
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420 CFM – Patient Cold Average Plot 
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Figure B.3: Averaged Velocity Vectors for 420 CFM, Patient Cold Case 

The data points from each individual run are color-coded as shown 
The average vector from all the runs is black 
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420 CFM – Patient Warm Average Plot 
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Figure B.4: Averaged Velocity Vectors for 420 CFM, Patient Warm Case 

The data points from each individual run are color-coded as shown 
The average vector from all the runs is black 
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APPENDIX C – CFD RESULTS 

330 CFM – Patient Cold 
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Figure C.1: 330 CFM, Patient Cold CFD Results 
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330 CFM – Patient Warm 
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Figure C.2: 330 CFM, Patient Warm CFD Results 
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420 CFM – Patient Cold 
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Figure C.3: 420 CFM, Patient Cold CFD Results 
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420 CFM – Patient Warm 

X

Y

0 0.5 1 1.5 2 2.5
0

0.5

1

1.5

2
velocity-magnitude

0.24
0.21
0.18
0.15
0.12
0.09
0.06
0.03
0

420 CFM - Patient Warm ⏐ 13 Nov 2007 ⏐ title

 
Figure C.4: 420 CFM, Patient Warm CFD Results 
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APPENDIX D – COMPLETE PIV PROCEDURE 

1. Open supply air to operating room 
a. Tweak pressure to VAV box in order to adjust the flow entering the 

operating room by adjusting the knob in the following figure. 

 
b. The volumetric flow rate (in CFM) entering the room can be calculated 

with the following equation.  The dynamic pressure, qD, used in the 
equation is read from a Dwyer 1” Manometer, shown below. 

DqQ ⋅= 2117  

 
2. Turn on Agilent Data Acquisition/Switch Unit 
3. Turn on power supply for Alnor Thermo-Anemometer 

a. Channels are assigned as shown in Section 2.1. 
4. Push play button in Agilent Data Logger window to start monitoring 
5. If a run with the patient heated is being done, turn on the Brookfield Heater Pump 

a. Monitor Channel 11 in Agilent Data Logger 
b. Typically takes about 1 hour to heat up to 85°F 

6. Power on Camera Positioner Power Supply and Laser Positioner Power Supply 

Adjustment Knob 

Opens flow 

Dwyer 1” Manometer
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7. Open proVISION-XS 
8. Set-up proVISION for a run 

a. Click “Open PIV Camera Session” 

 
1. Click Next > 

b. Create New Camera session as PIV Research 

 
1. Click Next >  

c. Enter the date for session name 

Laser Positioner 
Power Supply 

Brookfield Heater 
Pump 

Camera Positioner 
Power Supply 
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1. Click Next > Next > Next > Finish 

d. In main screen, ensure camera pad and camera settings are displayed 

 
e. Calibrate the camera 

1. Click on Calibration Settings 

 
2. If no changes have occurred since the last calibration, the last 

calibration image can be loaded by selecting the “Import 
calibration image” button from the calibration box and finding 
the calibration image from a previous run. 

 
3. If changes have been made, the camera needs to be calibrated. 
4. Place wood block with grid paper on top of simulated patient.  

Ensure that the grid is level and the plane of the grid is in the 
plane of the laser. 

5. Open Matlab 
1. Type “stepper” and hit enter 
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2. Check to make sure the camera is in the physical “Home” 
position before moving it 

 
3. Move to predefined position 8-Mp-Center 

 
6. Click “Play” in the proVISION camera controls box 

 
7. Change Brightness setting on camera until grid of grid paper is 

visible (settings shown below work well) 
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8. Adjust Camera Focus with outermost camera wheel 
9. Click on “Save Calibration Image” in Calibration Settings 

Window 
1. Click Next 
2. Enter date for calibration family name, click Next > Next > 

Finish 

 
10. Click “Calibrate” 

 
11. Make Grid size 50.8 50.8, Grid Nodes 9 x 9 
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12. Line up grid on screen with the grid of the grid paper 

 
13. Click OK in Generic Calibration Window 
14. Click OK again to finish Calibration 
15. Close Calibration Settings Window 
16. Click on PIV Settings 

 
17. Click on Mesh Tab 
18. Input the Mesh settings shown below 
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f. Remove check by mesh 

9. Power on laser (turn key) 
a. Press START button 
b. Start on internal (INT) control for both lasers 
c. Press LASER1 and LASER2 buttons simultaneously to start up laser 

10. Turn on fog to 15 psi 
11. Line up laser with field of camera using vertical laser adjustment switch (located 

near computer monitor) 
12. In the proVISION window, click Clock to adjust timing configuration 

 
a. On/Off 
b. Click Emission 
c. 1000 pulse separation  (controls time between laser pulses) 
d. .5 Hz camera freq. (freq of snapshots) 

 
13. Turn laser to computer control (EXT) for both lasers 
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a. Ensure level is set to high 
b. Press LASER1 and LASER2 buttons to start lasers again 

 
Steps for a typical run 

1. Using Matlab stepper program, move camera to pre-defined location 1 
2. Set laser manually to cut across the face of the camera 
3. Press play 
4. Manually focus camera until a fog particles are visible in the picture 
5. Set Camera settings Double Exposure 

 
6. Click on “Record” and then “Play” 

 
7. If this is the first capture of a run, the acquisition name will be “Acquis001”.  It is 

best to name the acquisition the same as the position number (eg Acquis005 for 
position 5) 

a. Click Save  
b. Wait for sequence to complete 

8. It’s a good idea to do a quick analysis of each sequence before moving the camera 
to ensure that a good reading was taken 

9. Click PIV Settings 
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a. Under the Correlation Tab 
i. Set the Mode to Adaptive 

ii. Turn off Auto Range and set to 
1. -16 to 16 in u-direction 
2. -16 to 16 in v-direction 

 
b. Under Vectors Tab, set Interp cut off to >40 

 
c. Under the Output Tab 

i. Set output to ASCII 
ii. Click on Launch Tecplot field 

 
d. Under the Sequence Tab 

i. Set number of images to 30 
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ii. Image stride 2 
iii. Click Process 

 
10. To step thru non averaged plots go to Tools>Animate Zones  
11. Continue moving the camera and taking measurements until all 25 positions have 

been completed. 
 
To analyze the sequence batch:  

1. If you analyzed each sequence as you took it, skip to Step 7 
2. Otherwise, click “Open PIV Images” in proVISION window 

 
3. Select date (or folder name) and acquisition run you want to analyze 

a. Click date>Acquis001>ImgA.tif 

 
4. Click on Settings 

a. Use the same Settings as shown above 
5. Hit Process 
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6. Go to the Start menu and MyComputer/F:PIVDB-Fall 2005 
a. Open your folder 
b. Open the date folder 

i. Acquis001>Analysis000 
1. Copy config.prv and mesh000.msh 

ii. Go to Acquis002>Analysis000 
1. Paste 

iii. Go to Acquis003>Anaylsis000 
1. Paste 

iv. And so on… This ensures a consistent mesh between all captures 
7. Go back to the proVISION window and select “Open PIV batch” 

 
a. Click “Yes” 

 
b. Click Next 
c. Click on the radio button next to “Add multiple image sequences….”   
d. Click Next 

 
e. Find your date 
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f. Click “Select All”, then Next 
g. Click on Analysis001 from Acquis001 (this will establish the analysis 

settings to be used) 
h. Click on Analysis Info and ensure that the settings are correct 
i. Click Next>Finish  
j. Click “Process!” 

 
8. Find the data from the data just analyzed 

a. Go to F:/PIVDB…/your date/your date/Acquis001/Analysis000 
i. Copy ImgA-Average (the AutoCAD plot) 
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b. Go to C:\Documents and Setting/Owner/Desktop/25 spot Traverse 

i. Paste file into folder corresponding to the position 
1. Positions 1-5 are in “Patient” folder 
2. Positions 6-10 are in “Mid-Patient” folder 
3. Positions 11-15 are in “Middle” folder 
4. Positions 16-20 are in “Mid-Top” Folder 
5. Positions 21-25 are in the “Top” Folder 

 
9. After all 25 are done, open Excel file titled “25 pt traverse Spread Sheet 

a. Enable macros 
b. Click Import when prompted (this updates the data in the spreadsheet for 

all 25 zones) 
c. Go to Tools>Macro>Visual Basic editor 

i. Click on “Forms” folder 
1. Double-click UserForm1 
2. Click “Play” 

 
d. Go to Sheet 3 
e. Click in the upper right hand corner of the spreadsheet to select all 
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f. Copy 
g. Open Notepad 
h. Paste data into notepad 
i. Save as date.dat (make sure Save as Type is All Files) 

 
j. Exit out of Excel, do not save 

10. Open Tecplot template file “patient_layout” 
a. Click File>Load Data File(s) 
b. Click on radio button next to “Replace data set and retain plot style 

 
c. Find the .dat that was just generated. 
d. The data collected will be displayed in Tecplot 
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APPENDIX E – STEPPER MOTOR CONTROLLER  

function stepx(dis) Defines function stepx and variable dis 
dio=digitalio('parallel',1); 
hline=addline(dio, 0:7, 'out'); 
if dis==0 If distance to travel is zero, end program 
    return 
else If distance to travel is less than zero, rotate  
  if dis<0 step motor counterclockwise 
      dir=0; 
  else  
      dir=1; If distance to travel is greater than zero,  
  end rotate step motor clockwise 
  distance=abs(dis); 
  putvalue(dio,0) 
     for i=0:1:ceil((distance/9.3750e-004)) Defines the distance traveled with each step  
         putvalue(dio,8*dir); to determine the number of steps required 
  
       putvalue(dio,8*dir+1); 
     end 
    putvalue(dio,16) 
end 
  
function stepy(dis) Defines the same routine for the y-direction 
dio=digitalio('parallel',1); 
hline=addline(dio, 0:7, 'out'); 
  
if dis==0 
    return 
else 
  if dis<0 
      dir=1; 
  else  
      dir=0; 
  end 
  distance=abs(dis); 
  putvalue(dio,0); 
     for i=0:1:ceil((distance/8.2500e-004)) 
         putvalue(dio,8*dir); 
       for j=0:1:300000 
       end 
       putvalue(dio,8*dir+2); 
     end 
   putvalue(dio,16) 
end 
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APPENDIX F – HEAT FLUX CALCULATIONS 

T_av=16 [C] 
P=101.325 [kPa] 
Cp_air=Cp(air,T=T_av) 
rho_air=density(air,T=T_av,P=P) 
Q_low=.1557 [m^3/sec] "330 CFM" 
Q_high=.1982 [m^3/sec] "420 CFM" 
m_dot_low=Q_low*rho_air 
m_dot_high=Q_high*rho_air 
ductarea=(20.5/39.37)^2*9 [m^2] 
 
wallarea=15.75 [m^2] 
heat_flux_low=Q_dot_cold_low/wallarea 
heat_flux_high=Q_dot_cold_high/wallarea 
 
 
"Temperature Data" 
T_in_cold_low=15.3449 [C] 
T_out_cold_low=15.9128 [C] 
DELTAT_cold_low=T_out_cold_low-T_in_cold_low 
 
T_in_hot_low=15.6293 [C] 
T_out_hot_low=16.3327 [C] 
DELTAT_hot_low=T_out_hot_low-T_in_hot_low 
Q_dot_cold_low=Cp_air*m_dot_low*DELTAT_cold_low 
Q_dot_hot_low=Cp_air*m_dot_low*DELTAT_hot_low 
 
G_dot_patient_low=Q_dot_hot_low-Q_dot_cold_low 
 
T_in_cold_high=15.3619 [C] 
T_out_cold_high=15.8295 [C] 
DELTAT_cold_high=T_out_cold_high-T_in_cold_high 
T_in_hot_high=15.4646 [C] 
T_out_hot_high=16.1174 [C] 
DELTAT_hot_high=T_out_hot_high-T_in_hot_high 
Q_dot_cold_high=Cp_air*m_dot_high*DELTAT_cold_high 
Q_dot_hot_high=Cp_air*m_dot_high*DELTAT_hot_high 
 
G_dot_patient_high=Q_dot_hot_high-Q_dot_cold_high 
q_dot_av=(heat_flux_low+heat_flux_high)/2 
 

05.7=avq& W/m2 
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